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Descripcion del equipo CompactRIO

En el capitulo anterior se describieron los elementos y funcionamiento de la planta piloto de tipo industrial, en
este capitulo se describe el equipo CompactRIO con el que es controlada. Se explican las caracteristicas de
hardware del equipo y el software que debe ser instalado en la PC del usuario para programarlo. También se
especifican los madulos de expansion usados de acuerdo a las sefiales eléctricas de los elementos de 1a planta.
Finalmente se describe paso a paso la configuracion y programacion de cada uno de los mddulos que son
usados.

El equipo CompactRIO es un sistema robusto de control y adquisicion de datos. Se conforma por un procesador
embebido en tiempo real para operacion confiable autonoma o distribuida y un dispositivo FPGA que
proporciona flexibilidad, alto rendimiento y fiabilidad de hardware personalizado. El tamafo reducido, la robustez
y su tecnologia hacen del equipo CompactRIO una alternativa eficaz para controlar y automatizar la planta piloto
de tipo industrial. Se conecta a la PC via Ethernet y el software con el que es manejado permite disedar,
programar y personalizar un sistema de control y automatizacion de la planta con herramientas de programacion
grafica. En la ilustracion 1 se muestra una foto del controlador que fue usado para controlar la planta piloto, un
equipo CompactRIO modelo 9074.

llustracion 1. Chasis Compact RIO
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2.1 Caracteristicas de hardware

El equipo Compact RI0-9074 esta integrado con un procesador industrial de 400 MHz para control, registro y
andlisis de datos en tiempo real, un dispositivo FPGA de 2M de compuertas, contiene ocho ranuras para
insertar modulos de entrada y salida de datos. Trabaja en un rango de temperatura de -20° a 55°C. El chasis se
energiza de 19 a 30 Ved y posee 128 MB de DRAM para operacion embebida y 256 MB de memoria volatil para
registro de datos.

Tiene dos puertos Ethernet que permiten comunicar el equipo con una PC para crear y ejecutar programas o
bien pueden usarse para expansion, es decir, para conectarse con otros dispositivos en red para enviar y/o
adquirir datos.
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llustracion 2. Compact RIO 9074

Para comunicar el sistema Compact RIO con una PC via Ethernet se debe conectar a la computadora a través
del puerto 1 con un cable Ethernet cruzado. En el anexo 1 se muestra la conexion especifica.

El equipo cRIO 9074 requiere una fuente de alimentacion externa. El cable positivo de la fuente se debe conectar
a la terminal V'y el negativo a la C, como se muestra en la ilustracion 3.
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llustracién 3. Conexion de alimentacion

Las terminales C estan conectadas internamente, por lo que el cable negativo se puede conectar en cualquiera
de las dos terminales. En este caso se utiliza una fuente de 24 V.

2.2 Caracteristicas del software

El software que se usa para manejar el equipo CompactRIO es LabVIEW, una herramienta de programacion
grafica de control y disefio de sistemas. Es necesario que la PC a la que se conecte el controlador NI cRI0-9074
cuente con el siguiente software y drivers:

LabVIEW 8.6

LabVIEW Real-Time 8.6
LabVIEW FPGA 8.6
NI-RI0 3.0.0

A continuacion se presenta una lista del orden de instalacion y los discos en los cuales encuentra el software
requerido.

1. Instalar LabVIEW version 8.6 con el disco NI ACADEMIC SITE LICENSE (NI LabVIEW Core Software
English)

2. Instalar LabVIEW FPGA Module 8.6 y LabVIEW Real-Time Module (ETS) del disco NI ACADEMIC SITE
LICENSE (Control and Embedded Systems Option Components).

3. Instalar NI-RIO 3.0.0 del disco NI ACADEMIC SITE LICENSE (NI Device Drivers).

Si la computadora tiene instalada alguna version anterior a la 8.6 se debe actualizar el software. Se puede
verificar 1a version y el software instalado en la PC dando doble clic en el icono de Measurement & Automation.

Actualizacion del software de la tarjeta de tiempo real del equipo CompactRIO

El procesador de tiempo real del equipo CompactRIO tiene una version del software NI-RIO instalada de fabrica y
en algunos casos no es compatible con la version del software instalado en la PC. Por esta razon se debe
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actualizar el software del CompactRIO. En éste caso, el software de fabrica del equipo cRI0-9074 era el NI-RIO
2.4.1 recomendado para uso de LabVIEW 8.5.

Sin embargo, el software instalado en la PC fué el NI-RIO 3.0.0 de acuerdo con la instalacion de LabVIEW 8.6.
Para actualizar el software en el equipo CompactRIO se realizan los siguientes pasos.

1. -Se conecta el cRIO a la computadora mediante un cable cruzado Ethernet.
2.- Se abre el explorador Measurement & Automation.

4

Measurement &
Automation

3.- En la columna del lado izquierdo de la ventana del Explorador da clic sobre Remote Systems después da clic
sobre CRI09074 y por ultimo da clic en Software. Las series de clics, como la que se acaba de describir, se van
a representar en las siguientes paginas como Remote Systems > >CRI09074> > Software.

i 44 Scales
& Software

H TIVErS
é g Remote Systems
£ [ CRI09074
&) Devices and Interfaces
= & Software

- abVIEW Real-
LabVIEW Real-Time 8.5

(@ Modbus /0 Server 140
MNetwork Variable Engine 1.4.0
NI-RIO 2.3.1

MI-Serial RT 3.3.0

MNI-VISA 4.2

NI-VISA Server 4.2
NI-Watchdog 21.5

* (@ Variable Client Support for La

1 2

- M
@ Software - Measurement & Automation Explorer - PA—— - LEIEIQ
Eile Edit View Tools Help
Configuration 1 Add/Remove w 2 Show Help
Bg My System \
: -
i@ [l Data Neighborhood
{6 B Devices and Interfaces Software

What is Software?
Software displays the National Instruments software components installed on a LabVIEW Real-Time target.

What do you want to do?
=View my software information
To expand Software in the configuration tree, click the plus sign (.

& Install software
To install software to your remote target, click the Add/Remove Software icon in the toolbar.

For more information about using your NI products, refer to your product-specific help, located on the Help»Help

or by pressing <F1l:.

Topics menu item. You can also access NI product help from within MAX help, which you can launch from the Help menu

Submit feedback on this topic

P Help

llustracion 4. Ventana del explorador.

4.- Dar clic sobre el boton Ada/Remove Software ubicado en el lado superior de la ventana del explorador.
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5.- En la pantalla aparece una ventana como la que se muestra en la ilustracion 5, seleccionar
with NI Scan Engine Support y después dar clic en Next>>.

NI-RIO 3.0.1

DV LabVIEW Real-Time 8.6

-#g2 NI-RIO 3.0.0 - August 2008

gL} MI-RIO 3.0.0 (minimal] - August 2008

- v MI-RIO 2.0.0 with NI 5can Engine support -
- t NI RIO 301 (m|n|mal] October 2008

o Click Mext to install the following recommended

software set to the target:

2008

for LabVIEW Real-Time 4.5.5
PID Control Toolkit 8.6

DataSod

- Uninstall all software

---E’[g Customn software installation (currently install

LabVIEW Real-Time 8.6
Modbus I/O Server1.5.0
NI Scan Engine1.0.0

o 7

NI-RIO 3.0.1 with NI 5can Engine support - October

-
LabVIEW Real-Time Software Wizard [
Software Selection
Select the recommmended software set you want to install to the target. Mational ﬂm&"ﬁ
Instruments recommends the following software sets for your target.

lLom | »

Update BIOS... |

<= Back [ Mext == ] [ Cancel l [

Help

llustracion 5. LabVIEW Real-Time Software Wizard

6.- Se abre una ventana nueva, como la de la ilustracion 6, con la lista de drivers que se actualizaran en el
equipo CRIO 9074 y dar clic sobre el boton Next>>.

LabVIEW Real-Time Software Wizard

| |

Review Selections

Review the following summary before continuing.

NATIONAL
ﬂNﬂRUMENTS'

LabVIEW PID Control Tocolkit 8.6
LabVIEW Real-Time 8.6
Medbus 1/0 Server 1.5.0

NI Scan Engine 1.0.0

MI-RIC 3.0.0

MI-RIO IO Scan 1.0.0

MI-Serial RT 3.3.2

MNI-VISA 4.4

MI-VISA Server 4.4
MI-Watchdeg 3.0.0

Metwork Variable Engine 1.5.0

Systern State Publisher 1.0.0

R T

Web Server for LabVIEW RT 1.0.0

Run-Time Engine for Web Services 1.0.0

Variable Client Support for LabVIEW RT 1.5.0

Drivers que seran
actualizados

_/

s

m

Click the Mext button to begin the update. Click the Back button to change your selections,

Update BIOS...

[ << Back ][ Mext == l [ Cancel l [

Help

llustracion 6. Lista de Driver a actualizar

7.- Si la instalacion se realiza de manera correcta aparecerd en pantalla un ventana notificando que la
actualizacion del software se terming correctamente.
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2.3 Médulos de expansion

En el capitulo anterior se cuantificaron y cualificaron las sefiales producidas por los transductores y las sefiales
que manejan los actuadores. Con base en esta informacion se planted el uso de los siguientes modulos de
expansion del equipo Compact RIO. Cabe mencionar que algunos de los modulos no soportan directamente las
sefales que manejan los elementos de la planta, esto es debido a que el departamento de control ya contaba
con algunos de ellos, por lo que para aprovecharlos se usé una etapa de acondicionamiento de sefiales.

Maddulo NI 9219 Al Universal

El modulo NI 9219 contiene 4 canales de entradas analdgicas. Este mddulo es utilizado para leer las sefales
enviadas por los tres transmisores de presion, dos que miden el flujo (FT-01y FT-02) y uno que sensa el nivel
del tanque abierto (LT-01). Soporta sefiales de voltaje de += 60V y de corriente de =25mA. Para este modulo
no se necesita una etapa de acondicionamiento ya que la corriente producida por los transmisores esta dentro
del rango requerido.

%

0
ES=

Cho

@
Q{@EHE
) EIele);

Elals)
©IElE)

DT
EISIE

Ch1

=z

CEIES

Ch2

OElo
ESIE

SleReC]

Ch3

©00
JIm
0001006

©

|

g

|

llustracion 7. M6dulo NI 9219
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Médulo NI 9401 DIO 5VTTL High Speed

El modulo NI 9401 contiene 8 canales de entradas y salidas digitales. En el proyecto en cuestion, es utilizado
para accionar las dos bombas (BA-01 y BA-02) y las dos vdlvulas solenoides (SV-01 y SV-02) de la planta.
También es el receptor de las senales emitidas por los dos sensores de nivel del tanque dos (LL y HL). En este
€aso es necesario usar una etapa de acondicionamiento debido a que el mdodulo trabaja con senales de 5Ved y
las valvulas, bombas y sensores de nivel manejan sefiales de 24 Vcd.
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llustracion 8. Mddulo NI 9401

Maédulo NI 9265 AQO Universal

El modulo NI 9265 contiene 4 canales de salidas analdgicas. El objetivo del modulo es controlar las dos
valvulas de globo de la planta (FY-01 y FY-02). Con este modulo se generan sefiales de corriente de hasta
20mA, sefial que cumple con las caracteristicas eléctricas requeridas por cada valvula, esto significa que no se
necesita una etapa de acondicionamiento de sefiales.
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A continuacion se presentan dos tablas donde se relaciona cada modulo al respectivo transductor o actuador al
que sera conectado.

TRANSDUCTORES CARACTERISTICAS MODULO NI SENAL
ELECTRICAS
Sensor de nivel 1 LL 0-24V NI 9401 Entrada Digital
Sensor de nivel2 HL 0-24V NI 9401 Entrada Digital
Transductor de nivel LT-01 4-20mA NI 9219 Entrada
Analdgica
Transductor de flujol  FT-01 4-20mA NI 9219 Entrada
Analdgica
Transductor de flujp2  FT-02 4-20mA NI 9219 Entrada
Analdgica

Tabla 1. Actuadores y mddulo de control

ACTUADORES CARACTERISTICAS MODULO NI SENAL
ELECTRICAS
1 BOMBA 1 HP BA-01 0-24V NI 9401 Salida Digital
1 BOMBA 2 HP BA-02 0-24V NI 9401 Salida Digital
Valvula Solenoide 1 SV-01 0-24V NI 9401 Salida Digital
Vélvula Solenoide 2 SV-02 0-24V NI 9401 Salida Digital
Valvula Anal6gicat FY-01 4-20mA NI 9265 Salida
Analdgica
Valvula Anal6gica2 FY-02 4-20mA NI 9265 Salida
Analdgica

Tabla 2. Instrumentos de medicion y médulo de control

2.4 Configuracion y Programacion de Modulos

Configuracion del mdédulo NI 9219 Al Universal
PASO 1.- Abrir LabVIEW 8.6

LabVIEW

PASO 2 - En la ventana Getting Started, dar clic sobre la opcién Empty Project.
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{3 Getting Started ==l

File Operate Tools Help

.......

m LabVIEW Licensed for Professional Version

New New To LabVIEW?
"l Blank VI Getting Started with LabVIEW

JEQ Empty Project LabYIEW Fundamentals

E Real-Time Project
=3 More...

Guide to LabVIEW Decumentation

LabVIEW Help

Upgrading LabVIEW?
Open

Automatic Block Diagram Clean Up
E; pruebaunoc.lvproj

[l iodigital.lvproj Quick Drop
|;g gjem.vi Properties of Multiple Objects
[l DIOdos.wvi List of All Mew Features
[l DIOunowi Web Resources
Eg EJERCICIOZ.vi Discussion Forums
) Browse...
J Training Courses
Ta LabVIEW Zone
Examples

FPGA Project

rojec Iz‘ Q\ Find Examples...

J

llustracion 10. Ventana Getting Started

PASO 3.- Aparece la ventana Project Explorer que se muestra en la ilustracion 11. Da clic sobre File>> Save
Project e indicar la direccion en la cual se desea guardar el proyecto, asi como su nombre.

{3 Project Explorer - Untitled Project 1 I.E‘Elﬁ
File Edit VNiew Project Operate Tools Window Help

[ Se| xR0 x|k @ ol

Items | Files

= [l Project: Untitled Project 1
B B My Computer
_'-E' Dependencies
'.-._ Build Specifications

=

i - = - ¥
llustracion 11. Ventana Project Explorer
PASO 4.- En éste caso el nombre del proyecto es PRUEBAUNO. Ahora en la ventana Project Explorer dar clic

derecho sobre Project: pruebauno.lvproj, selecciona NEW y después TARGETS AND DEVICES. Como se observa
en la ilustracion 12.
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{3 Project Explarer - pruehauno.vproj E@Iﬂ

File Edit View Project Operate Tools Window Help

EECIE IECIER ]

Irerns ‘ Files |

= B Target Folder
& § My Computer
% Dependencies Explore...
" Build Specificalt  Show in Files View Ctrl+E -
| New...

Save
Save As...
Save All (this Project)
Mass Compile...

View »
Find Items with No Callers
Find Missing Items

Import 4

Expand All
Collapse All

Rename... F2

Properties

llustracién 12. Pruebauno.lvproj

PASO 5.- En la ventana Add Targets and Devices se debe seleccionar la opcion  Existing target or device, se da
clic sobre Real-Time CompactRIO, se seleccionar ~ CRI09074 y se da clic en OK. (El equipo CompactRIO
debe estar conectado a la PC).

i3 Add Targets and Devices on pruebaunc.lvproj ﬂ

Targets and Devices

[
i@ Existing target or device
- ISCOVEr an existing target(s) or device(s).
("1 Buisting device on remote subnet
Specify a device on a remote subnet by address,
(") New target or device H

Create a new target or device by type.

Targets and Devices -~
[/ FieldPoint Network Modules
E|E:| Real-Time CompactRIO
- [ crios074
[a Real-Time Desktop
[ Real-Time FieldPoint
(3 Real-Time PXI
[+ Real-Time Single-Board RIO

] [ | 3

ok [ cancel |[ Hep

N llustracion 13. Agrega dispositivos al proyecto

PASO 6.- Se abre la ventana para escoger el modo de programacion, este debe ser LabVIEW FPGA Interface.
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r - L T
_ﬂ Select Programming Mode . - &J

Select the programming mode you want to start programming your selected system(s) with:

Programming Mode

©) Scan Interface

The Scan Interface enables you to use C Series modules directly from LabVIEW Real-
Time.

™
_ @ LabVIEW FPGA Interface
ela nterface enables you to use C Series modules from LabVIEW FPGA

Vs,

Note: Selecting LabVIEW FPGA Interface mode stops any Scan Interface mode
applications running on the system(s).

[ Continue ] [ Cancel ] [ Help

llustracion 14. Escoge un modo de programacion

PASO 7.- Ahora se observa en la ventana Project Explorer el Chassis cRI0-9074, la tarjeta FPGA y los mddulos
conectados en el chassis.

{3 Project Explorer - pruebauna.lvpraj * E@g

Eile Edit Niew Project Operate Tools Window Help
It % IECYERE
Iterns | Files |

PRy ——

2+ B My Computer

Dependencies

[ i Build Specifications

& [3, CRIOS074 (169.254.125.17)

= Bl Chassis (cRIO-9074) <—— o
=" @ FPGA Target (RIO0, cRIO-9074) €=

@ [ ChassisI/O

m- [ Modl

@ Mod2

- EB 40 MHz Onboard Clock

[i Modl (Slot 1, NI9219)

[I Mod2 (Slot 2, NI9401)

EE' Dependencies

't Build Specifications

QE';' Dependencies i

i Build Specifications

—

llustracion 15. Ventana Project Explorer

En la ventana Project Explorer da clic derecho sobre FPGA TARGET > >NEW> >Vl
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i3 Project Explorer - pruebauno.lvpraj *

File Edit View Project Operate Teels Window Help

|k=E=1<1F"
Items | Files |
= [l Project: prugbauno.lvproj
E] E My Computer
Dependencies
t Build Specifications
= [ CRIOS074 (169.254.125.17)
- Chassis (cRIO-9074)
= ﬁg v
[ Chassis /O "
: Virtual Fold,
I Q Modl Execute VIon ruel Forder
Q Mod2 ) Control
L BB 40 MHz Onboard Cloi IO Device Setup... Library
o (R CESHNERT p—— Statechart
- N Mod2 (Slot 2, NI 9401
; ;—'E Dependencies Add » C Series Modules...
w D'E Build -Speci‘ﬁ cations Armange by N FPGA /'O
g ependencies FPGA Base Clock
- & Build Specifications Expand All
FIFO
Cellapse All
Memory
N ———————— A
Remove from Project Component Level IP
Rename.. F2
Help...
Properties

llustracién 16. Agrega un VI nuevo

Una vez hecho lo anterior, se abre el panel frontal y la ventana de diagrama de bloques de LabVIEW. Se debe
guardar el archivo dando clic en File> >Save as y asignar el nombre deseado. En este caso Ejemplouno.

De la paleta de funciones se selecciona FPGA I/0 >> FPGA I/0 Node, como se muestra en la ilustracion 17.

Eile Edit Miew Project Operate Tools Window Help .‘ Eile Edit View Project Operate Tools Window Help .

(2]@] @ [15pt Appication Font |~ |[ 2o |[m ][ >le]@ [15pt Application Font |« |

41 Functions O\Sealch|
Programming +
L4
== E
=l
141 FPGAT/O
. LKL d
1k
Addens
Favorites =
Select a VI...
Statechart 4
| pruebauno.lvproj/FPGA Target «

llustracion 17. Nuevo VI

Ya que se ha colocado el FPGA 1/0 Node sobre el diagrama de bloques de LabVIEW, dar clic derecho sobre él'y
dar clic sobre Select FPGA 1/0> >Mod1>>Mod1/CHO.
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B /O ltemS
Visible Items 3
Help

Examples

Description and Tip...

Breakpoint 3
FPGA /O Palette »
Create 3
Replace 4

Find FPGA /O in Project
Show Error Terminals

Change to Write
Add Element
Remove Element
Add New FPGAT/O...

Chassis /O »

Modl/CHO

3 Modl/CH1
Modl/CH2
Modl/CH3

Properties

llustracion 18. Inserta un nodo

Ya que se ha configurado el Nodo, entonces se debe construir un VI para observar los datos adquiridos por el
Madulo NI'9219 como el que se muestra en 1a figura de abajo.

e
i3 Ejemplouno.vi Front Panel on pruebaunc.ivproj/FPGA Target = L‘:' ‘ = ‘ = J i3 Ejemp wvi Block Diagram on pmebauna‘l...ti‘glg
File Edit View Project Operate Tools Window Help ‘D@ File Edit View Project Operste Tools Window q{jg
@ | 15pt Application Font \v”!pv”EV'lﬁVI El @ | 15ptAppI|4 ]
EJEMPLO UNO ATUNIVERSAL
NI 9219
Waveform Chart Plot0
10 Modl/CHO
] 7
< B an Wodl/CHOG|
E = Waveform Chart =
o 0-
E
<
5
10+, '
0 100 stop
Time m
Modl/CHO Il
0.0000000000000000000000000000 STOP I
= -
pruebauna.lvproj/FPGA Target] « [ m ] + pruebaunc.lvproj/FRGA Target ¢ 0 v

llustracion 19. VI ejemplo del médulo NI 9219

Se da clic sobre el boton RUN para que el VI sea ejecutado. En la pantalla aparece una ventana que indica
el porcentaje de Archivos Intermedios Generados como la de la ilustracion 20.
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i3 Generating Intermediate Files | SRECL

Generating intermediate files.
This may take a few minutes...
Stage 4 of 6

Processing diagrams 23 of 23

Total 62%

Cancel

llustracion 20. Progreso del generador de archivos

Después aparece la ventana LabVIEW FPGA Compile Server 8.6.0, en donde se muestra el Server Service ID,
Client Service ID, Client Name, Status, Start Time, Last Update Time, Details y el Server Status. Mientras el VI se
encuentre compilando en la celda Server Status aparece la leyenda Compiling. Los datos de las celdas de esta
ventana aparecen por default y solo se tiene que esperar a que el proceso de compilacion sea terminado.

{3 LabVIEW FPGA Compile Server 8.6.0 l ==
Compile Status
Server Service ID Client Service ID Start Time
5 pruebauno_FPGATarg~A7_Ejemplouno_rMdkpenl ~66 02/03/2009 11:35:55a.m.
Client Name Status Last Update Time
localhost Compiling VHDL 02/03/2009 11:35:5% a.m.
Details
Using Flow File; C;\WIFPGASS \srvrTmp\LOCALH~1\PRUEEA ~3/fpga. fiw &

Using Option File{s):

CH\NIFPGAZS sy Tmp \LOCALH ~1\PRUEBA ~3//balanced. opt
C\WIFPGASS sy Tmp \LOCALH ~1\PRUEBA ~3/bitgen.opt
C\NIFPGASS \srvr Tmp\LOCALH~1\PRIUEBA ~3fvhdl307x.opt

Creating Script File ...

m

# Starting program xst
# ust -fn toplevel_gen_xst.scr -ofn toplevel_gen_xst.log

7 7+ e

Server Status Compiling.
Compile List... [ Stop Compile ] [ Stop Server ] [ Help

llustracion 21. Compilador FPGA
Una vez que el VI se ha terminado de compilar, en la celda Server Status aparecera la palabra /dle.

A su vez también se desplegard en pantalla la ventana de la ilustracion 22 que muestra un reporte de la
compilacion del VI.
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ﬂ Successful Compile Report
P! P

Summary lAdvanced .

Status: Compilation successful. -
Compilation Summary
Logic Utilization: e
Humber of Slice Flip Flops: 1,236 out of 40,960 3% T
Humber of 4 input LUT=: 1.869 out of 40,960 4%
Device Utilization Sunmary:
Humber of BUFGHUXs 2 out of 8 25% -
Humber of LOCed BUFGHIE= 1 out of 2 S0
Humber of External I0Bs 167 out of 333 50%
Humber of LOCed IOBE= 167 out of 167 100
Humber of MULT18X1i8s 1 out of 40 2%
Humber of Slices 1300 out of 20480 B
Humber of SLICEM= 6 out of 10240 1%
Clock Rates: (Reguested rates are adiusted for jitter and accuracy) i

Do not show this
" message in the future

llustracion 22. R-eporte de compilacién

En el panel frontal del VI, se observa la grafica de |a sefial que esta siendo leida a través del mddulo NI 9219. En

este caso es una sefial DC de 15 V.

i3 Ejemplouno.vi on pruebauno.lvpro)/FPGA Target

File Edit View Project Operate

..gp

Tools

Window Help

3

EJEMPLO UNO
NI 9219

Waveform Chart

ATUNIVERSAL

p

oto [ |

17-

=
[=3]
1

Amplitude
v
1

-
I~
1

13-
a0as
Time

Modl/CHO
15.326278209686279296875000000¢

m

1
9195

|

pruebauno.lvproj/FPGA Target| « |

(L

llustracion 23. Panel frontal del ejemplo uno
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Configuracion del médulo NI 9401 DIO 5 V TTL High Speed

En la programacion de éste modulo se deben realizar los pasos del 1 al 7 descritos anteriormente en la
programacion del modulo NI 9219.

ﬂ Project Explorer - pruebauno.vproj * E@Ig

File Edit View Project Operate Tools Window Help

[tSal s DOX]|ERIR-

Items | Files |

= E. Project: pruebauno.lvproj

E} B My Computer

l;-'b;' Dependencies

‘é Build Specifications

= CRIO3074 (169.254.125.17)

= @ Chassis (cRIO-9074)

B 8 FPGA Target (RIO0, cRIO-9074)

[ Chassis/O

m- [ Medl

G- Mod2

i ¥B 40 MHz Onboard Clock
- f} Modl (Slot 1, NI9219)

Mew
@ Ejemplouno.wi

qbg Dependencies

‘é Build Specifications
';-'b;' Dependencies

- ‘é Build Specifications

Remove from Project

Rename... F2

Help...

| Propettes |
llustracion 24. Ventana del explorador del proyecto

Para usar el modulo NI 9401 de manera correcta primero se deben de configurar sus canales segun el uso

deseado. En este caso los canales del 0 al 3(DI03:0) se configuran como entradas(/nput) y los canales del 4 al
7(DIO7:4) como salidas (Ouiput).

§3 C Series Module Properties 0 e ———— o et [

Catego
ol I1odule Configuration|

Module Configuration

Name
[Mod2 |

Module Type

I 9401 8-Ch High-Speed TTL Digital 'O

Lecation

[slot 2 [=]

DI03:0

Input IH

[ ok [ cancel |[ Help

llustracion 25. Propiedades del m6dulo NI 9401
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Una vez configurado el modulo de entradas y salidas digitales, ubicarse nuevamente en la ventana Project
Explorer, dar clic sobre FPGA Target>>New>>VI. Como se observa en la ilustracion 16.

En la ventana de diagrama de bloques del nuevo VI, se agrega un FPGA 1/0 Node, se da clic derecho sobre él, da
clic sobre Select FPGA 1/0>>Mod2> >Mod2/DI00.

" VOke ™

Visible ltems 3
Help

Description and Tip...
Breakpoint

FPGAYT/O Palette
Create

v v v | v

Replace
Show Error Terminals

Add Eiement

Add New FPGAL/O...
Select FPGA /O

Chassis VO »
Mod1 13

Properties
Mod2/DIO0

Mod2/DIOL
Mod2/DIO2
Mod2/DIO3
Mod2/DIO4
Mod2/DIOS
Mod2/DIO6
Mod2/DIOT
Mod2/DI03:0
Mod2/DIOT:4
Meod2/DIOT:0

llustracion 26. Nodo para recibir datos

Después se agrega otro FPGA 1/0 Node, se da clic derecho sobre él, del ment que se despliega busca Select
FPGA 1/0>>Mod2>>Mod2/DIO7.

0 m
E\lmb\a Ttems 4

Help

Description and Tip...
Breakpoint

FPGAT/O Palette
Create

v | v v -

Replace
Show Error Terminals

Add Element

Add New FPGA/O...
Select FPGAL/O Chassis/O »
Modl 4

Properties

Mod2/DI00
Mod2/DI01
Mod2/DI102
Mod2/DI103
Mod2/D104
Maod2/DI0S
Mod2/DI06
Mod2/D103:0
Mod2/DI0T:4
Mod2/DI10T:0

llustracion 27. Nodo para enviar datos

Nuevamente da clic derecho sobre el Nodo Mode2/DI07 y del ment que se despliega busca la opcion Change
to Write.
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B i Mod2/DFoTR

Visible Items »
Help

Examples

Description and Tip...

Breakpoint 4
FPGA /O Palette »
Boolean Palette »
Create »
Replace »

Find FPGAL/O in Project
Show Error Terminals

Change to Write

Add Element

Remove Element

Add New FPGAT/O...

Select FRGAL/O »

Properties

llustracién 28. Configuracion del nodo para enviar datos

En éste ejemplo se debe construir un VI como el que se muestra a continuacion, el boton Mod2/DIO7 es un
control que produce una sefal on/off de salida por el canal 7 del mdadulo NI 9401 y el led Mod2/DI00 nos indica
el dato de entrada on/off del canal 0.

File Edit View Project Operate Tools Window Help 7 Eile Edit Wiew Project QOperate Tools

ee BEE

DIO 5 V TTL High Speed

Mod2/DI00

I
B s Mod2/DI00G|...... ..
i

Mod2/DI07

I
F BT Mod2/DI0T Y

=

pruebauno.vproj/FPGA Target|

llustracion 29. VI del mddulo NI 9401

Una vez que el VI estd listo, se debe dar clic sobre el botén RUN para iniciar el proceso de compilacion.
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Configuracion del médulo NI 9265 AO 20 mA

Para la configuracion de éste mddulo se deben realizar los pasos del 1 al 7 descritos en la configuracion del
maddulo NI 9219.

{3 Project Explorer - Untitled Project 2 * lﬂlﬂlﬂ

File Edit View Project Operate Tools Window Help

PoSd| kLD X|| k| & o

Items | Files ‘

= &l Project: Untitled Project 2
£ B My Computer
¢ L Dependencies

i '@ Build Specifications
= [, CRIO9074 (169.254.125.17)
E- @ Chassis (cRIO-3074)

=m0

B [i Mod2 (Slot 2, NI9219)
- "5 Dependencies
‘& Build Specifications

llustracion 30. Ventana del explorador del proyecto

No es necesario configurar los canales del modulo NI 9265 porque estos son Unicamente de salida, a diferencia
del modulo NI 9401 cuyos canales pueden ser de entrada o salida.

3 C Series Madule Properties ﬂ
Categos Module Configuration
Module Configuration|
Name
Modl
Module Type
NI 9265 4-Ch0-20mA 16-bit Analeg Current Output
Location
Slot1 =]
[ ok |[ canca |[ Help

llustracion 31. Propiedades del m6dulo NI 9265
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(=] © ]
File Edit View Project Operate Tools Window Help

oS xboX[ER &

§3 project Explorer - Untitled Project 2 *

Items Files

= [

=3 @ Project: Untitled Project 2
= B My Computer

qﬁ';' Dependencies
"‘ Build Specifications

Add

Simulation Subsystem

L% Builds{ Deploy Al

Virtual Folder
Connect
o Centrol
Disconnect
Utilities 4 Library
Variable
Deploy 1/0 Server

Disable Autodeploy Variables

Statechart

Targets and Devices...
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Expand All
Collapse All

Rename...

Remove from Project

F2

Help...

Properties

llustracion 32. Nodo para recibir datos

Como se muestra en la ilustracion 32, se da clic derecho sobre CRI09074, en el mend que se despliega se da

clic sobre NEW y después sobre VI.

En la pantalla aparece la ventana de diagrama de bloques. Para agregar los canales de salida a 1a ventana de
diagrama de bloques es suficiente con dar clic sobre la etiqueta del canal AOO de la ventana del explorador de
proyectos y arrastrarla hasta el diagrama de blogues como se muestra en la ilustracion 33.

{3 Untitled 2 Block Diagram on Untitled Project 2/CRL. ‘EIM'

File Edit View Project Operate Tools Window Help ‘

@ ©|E| L (B |of |15ptAppI\cationH

=

{3 project Explarer - Untitled Project 2 *

@MI

File Edit View Project Operate Tools

Window Help

el « b

|| &5 ¥ | B

|

Ttems | Files |

=[] Project: Untitled Project 2
=) W My Computer
. Dependencies

- ‘é Build Specifications
£ [ CRIO9074 (169.254.125.17)
[ [ Chassis (cRIO-9074)
LB lot1, NI

A0L

A02

a AO3

[I Mod2 (Slot 2, N19219)
Lo, Untitled 2

'T'-'f:,9 Dependencies

‘% Build Specifications

mn

74 « 1l

-

m

llustracion 33. Inserta el canal al diagrama de bloques.

Para este ejemplo se puede construir un VI como el que se muestra en la ilustracion 34. El

maodulo

9265

posee canales Unicamente de salida por lo que se usa una perilla como control para generar sefiales dentro de

un rango de valores de 0 a 20 mA.
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vi Block Diagy onUnﬁL..lDlﬁll & |

ﬂ ejemplodos.wvi on Untitled Project 2/CRIO9074 : 1o

File Edit View Project Operate Tools Window Help E File Edit View Project Operate Iools Wi
o~ r

B[] [@[n][@][z5] ba & o2

Perilla 0-20 mA
% 0.01618:
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Untitled Project 2/CRIO9074 | « i Untitled Project 2/CRIOS074 « [ m | ol

llustracion 34. VI del mddulo NI 9265
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